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Capítulo 1: Introducción

Capítulo 1: Introducción
Storyboard Pro es un storyboard completo y un software de creación de animática para funciones animadas, 
series de TV, proyectos que mezclan 2D y 3D, producciones de acción en vivo, videojuegos o eventos con 
funciones avanzadas.

En esta Guía de introducción, aprenderá los conceptos básicos sobre el uso de las funciones principales de 
Storyboard Pro, lo que lo pondrá rápidamente al corriente. Consulte la documentación completa de Toon Boom 
Storyboard Pro disponible en línea en docs.toonboom.com para aprender acerca de todas las herramientas y 
opciones, así como sobre las técnicas avanzadas.
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Capítulo 2: Creación de un proyecto

Capítulo 2: Creación de un proyecto
Al abrir Storyboard Pro por primera vez, aparecen dos cuadros de diálogo. El primero proporciona vínculos 
para:

 l Aprender a utilizar Storyboard Pro.

 l Conocer las novedades de esta versión de Storyboard Pro.

 l Participar en el foro de Toon Boom, donde puede cambiar información con otros usuarios de Storyboard 
Pro, realizar preguntas y obtener respuestas.

Al cerrar la primera pantalla de bienvenida, se mostrará la segunda, en la que se pueden crear y abrir proyectos.
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CONSEJO

Una vez en la ventana principal de la aplicación, puede volver a la pantalla de bienvenida 
seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de bienvenida) en el 
menú superior.

Creación de un proyecto desde la pantalla de bienvenida

 1. En el campo Project Name (Nombre de proyecto), escriba el nombre del proyecto. Este nombre 
aparecerá como el nombre del archivo.

 2. En el campo Project Directory (Directorio de proyectos), especifique la ubicación del nuevo proyecto.

 3. En el campo Project Title (Título de proyecto), escriba el nombre del título del proyecto. Es una 
buena idea usar la información del campo Project Name (Nombre de proyecto) para el campo Project 
Title (Título del proyecto). También puede escribir el nombre de Project Subtitle (subtítulo del 
proyecto), pero no es obligatorio. Estos títulos aparecerán en las exportaciones de PDF del 
storyboard.

 4. En el menú Camera Size (Tamaño de cámara), seleccione la resolución del proyecto.
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Capítulo 2: Creación de un proyecto

 5. Haga clic en Create Project (Crear proyecto).
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Capítulo 3: Acerca de la interfaz de usuario

Capítulo 3: Acerca de la interfaz de usuario
Al iniciar Storyboard Pro por primera vez, se presenta el espacio de trabajo predeterminado. Contiene todos los 
elementos principales que necesita para la creación de un storyboard.

Vistas
La interfaz de usuario de Storyboard Pro se compone principalmente de vistas, que son secciones del espacio 
de trabajo con un propósito específico y un conjunto de funciones. Cada vista tiene una pestaña sobre ella y se 
puede anclar en la ventana principal de la aplicación o hacer que se presente sobre ella en su propia ventana.

Adición de una vista al espacio de trabajo como una pestaña

 1. En la esquina superior derecha de una vista existente, haga clic en el botón Add View (Agregar 
vista) .
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 2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestaña en la sección del espacio de trabajo donde la agregó.

Adición de una vista al espacio de trabajo  como una ventana

 1. Abra el menú Windows (Ventanas).
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Capítulo 3: Acerca de la interfaz de usuario

 2. En el menú Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecerá como una nueva ventana sobre la ventana de la aplicación principal de 
Storyboard Pro.

Anclaje de una ventana de vista en el espacio de trabajo

 1. Haga clic y arrastre la vista flotante por su pestaña y realice una de las siguientes acciones:

 l Coloque la ventana sobre otra pestaña para agregarla a ese conjunto de pestañas.

 l Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse al 
borde de una vista, aparece un rectángulo cian que indica dónde se anclará la vista.

Vistas de escena y de cámara
la vista de escena es la vista principal de  Storyboard Pro. Se utiliza para ver y editar el panel seleccionado. 
Puede dibujar capas en el panel, manipular elementos en él, así como crear y visualizar movimientos de la 
cámara.
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La vista de cámara se parece mucho a la vista de escena, y no es necesario utilizarla si solo tiene la intención de 
trabajar en 2D. Sin embargo, si tiene pensado trabajar con modelos 3D, para colocar los elementos a distintas 
distancias de la cámara o rotar capas en 3D, la diferencia es importante: al trabajar en 3D, la vista de escena 
permite ver la escena desde cualquier punto de vista en el espacio 3D, mientras que la vista de cámara siempre 
muestra una vista previa de la escena desde el punto de vista de la lente de la cámara, lo que indica que 
representa con precisión lo que aparecerá al exportar el storyboard.

Panel de capas
El panel de capas aparece en una sección situada a la derecha tanto de la vista de escena como de la de cámara. 
Le permite agregar, eliminar, duplicar, agrupar, reordenar, ocultar, mostrar, bloquear o desbloquear capas, 
habilitar o deshabilitar animación en capas, cambiar la opacidad de una capa y seleccionar en qué capa se debe 
dibujar, manipular o animar.
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Capítulo 3: Acerca de la interfaz de usuario

Vista de imágenes en miniatura
La vista de imágenes en miniatura muestra todos los paneles del storyboard en orden cronológico de izquierda 
a derecha. Mediante esta vista, puede navegar por el storyboard, reorganizar paneles y escenas, y seleccionar 
qué panel se debe mostrar en las vistas de escena o de cámara.

Vista de línea de tiempo
La vista de línea de tiempo es la vista que se debe usar en lugar de la de imágenes en miniatura cuando desee 
crear una animática. Una animática es un vídeo basado en su storyboard, en el que cada panel está 
sincronizado para que aparezca aproximadamente durante la acción que representa, y en el cual se animan los 
movimientos de la cámara, para servir como base para el tiempo en la película. Al igual que la vista de imágenes 
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en miniatura, la vista de línea de tiempo le permite crear y gestionar paneles y escenas. También le permite, 
entre otras cosas, decidir cuánto tiempo tardan cada escena y cada panel en la animática, animar los 
movimientos de cámara, animar capas y agregar clips de sonido, imágenes y vídeos en la animática.

Vista de panel
La vista de panel muestra la información básica sobre el panel seleccionado actualmente. También permite ver y 
editar cuadros de texto en el panel actual, así como agregar bocetos o anotaciones de voz al panel.
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Capítulo 3: Acerca de la interfaz de usuario

Vista de Storyboard
La vista de storyboard muestra información básica sobre el proyecto. También permite escribir, importar, ver y 
editar el guion del storyboard.

Vista de propiedades de la herramienta
La vista de propiedades de la herramienta contiene las opciones y operaciones disponibles para la herramienta 
seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas Tools (Herramientas), la 
vista de propiedades de la herramienta se actualiza para mostrar sus opciones disponibles.
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Barras de herramientas
La interfaz de Storyboard Pro contiene varias barras de herramientas que proporcionan acceso a muchas 
herramientas útiles.Las barras de herramientas más importantes de Storyboard Pro son Tools (Herramientas), 
Storyboard y Playback (Reproducir).

Barra de herramientas Tools (Herramientas)
La barra de herramientas Tools (Herramientas) contiene las herramientas principales que necesita para trabajar 
en Storyboard Pro.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el lado izquierdo de la 
interfaz. Un pequeño triángulo en la esquina inferior derecha de una herramienta indica que se pueden 
seleccionar herramientas adicionales en un menú emergente. Para acceder a estas herramientas, haga clic y 
mantenga pulsado el botón de herramienta, o seleccione la herramienta y haga clic de nuevo.

Barra de herramientas Storyboard
La barra de herramientas Storyboard contiene todos los comandos básicos relacionados con la adición y 
eliminación de paneles, escenas y transiciones, así como el cambio entre las zonas de trabajo 2D y 3D.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la 
interfaz.
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Capítulo 3: Acerca de la interfaz de usuario

Barra de herramientas Playback (Reproducir)
La barra de herramientas Playback (Reproducir) permite reproducir el storyboard. Al crear una animática con 
transiciones y sonido, puede reproducirla en tiempo real en la vista de escena para comprobar el tiempo.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la 
interfaz.

Menú superior
El menú superior contiene la mayoría de los comandos disponibles en  Storyboard Pro. Según la vista en la que 
esté trabajando y el elemento seleccionado, algunos comandos están disponibles y otros no. El menú superior 
siempre está situado en la parte superior de la interfaz.

Aquí se proporciona una breve introducción sobre el objetivo de cada menú en el menú superior:

Menú Descripción

Storyboard 
Pro

Permite acceder al cuadro de diálogo About (Acerca de nosotros) y también al cuadro de diálogo 
Preferences (Preferencias). Esté menú solo está disponible en macOS.

Archivo
Contiene elementos relacionados con la creación, el almacenamiento, la exportación y la 
importación de los proyectos.                     

Editar
Contiene comandos para cortar, copiar y pegar paneles o capas seleccionados, para seleccionar 
paneles o capas y para agrupar o desagrupar capas. En Windows, también es la ubicación del 
menú Preferences (Preferencias).                     

Vista Permite panear, hacer zoom o rotar la vista actual, restablecerla a su punto de vista 
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Menú Descripción

predeterminado, y habilitar y deshabilitar determinados modos de vista, como el papel cebolla o la 
mesa de luz.                     

Reproducir
Permite reproducir y pausar la animática, así como navegar por los paneles y las escenas del 
storyboard.                     

Storyboard
Permite gestionar las escenas, paneles y secuencias del proyecto, agregar transiciones, 
marcadores, instantáneas, y trazar los cambios realizados al proyecto. También es donde se puede 
acceder al cuadro de diálogo Project Properties (Propiedades del proyecto).                     

Capa
Contiene una amplio conjunto de comandos para gestionar las capas de dibujo en el panel actual, 
así como los efectos que puede aplicar a las capas.                     

Cámara
Contiene varios comandos para ayudar a gestionar la posición y la animación de la cámara en una 
escena.                     

Clips Contiene comandos para editar y obtener vistas previas de vídeo y clips de sonido.

Cuadro de 
texto

Permite agregar, eliminar, buscar y establecer el formato para los cuadros de texto.

Herramientas
Permite seleccionar una de las herramientas de la barra de herramientas Tools (Herramientas), así 
como ordenar, transformar y convertir las formas y líneas que componen los dibujos.

Windows
Permite cambiar entre espacios de trabajo, administrar espacios de trabajo y acceder a las 
distintas vistas y barras de herramientas disponibles en Storyboard Pro.                     

Ayuda
Permite acceder a la documentación, los foros de Toon Boom, participar o dejar de participar en el 
programa de mejora de la experiencia del cliente, así como comprobar si existen actualizaciones. 
En Windows, también es donde puede acceder al cuadro de diálogo About (Acerca de nosotros).                     

Desplazamiento por la interfaz
Toon Boom Storyboard Pro permite acercar, alejar, rotar, panear y restablecer vistas para navegar fácilmente 
por la interfaz.

Los comandos de navegación de la tabla que se muestra a continuación se pueden utilizar en las siguientes 
vistas, con algunas excepciones:
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Capítulo 3: Acerca de la interfaz de usuario

 l Escena

 l Cámara

 l Línea de tiempo

 l Función, editor

 l Lateral y superior

Comando Acción Métodos de acceso

Zoom In (Acercar) Acerca la vista. 

View > Zoom In (Ver > Acercar)

Pulse 2

Gire la rueda del ratón hacia arriba (excepto en 
la vista de línea de tiempo)

Zoom Out (Alejar) Aleja la vista.

View > Zoom Out (Ver > Alejar)

Pulse 1

Gire la rueda del ratón hacia abajo (excepto en 
la vista de línea de tiempo)

Zoom In or Out 
(Acercar o alejar)

Acerca o aleja la vista.

Gire la rueda central del ratón hacia arriba o 
hacia abajo.

Mantenga pulsada la barra espaciadora y la 
rueda central del ratón mientras arrastra el 
ratón hacia arriba o hacia abajo.

Pan (Panear)
Mueve la vista horizontal o 
verticalmente.

Mantenga pulsada la barra espaciadora y 
arrastre en la dirección que desee panear la 
vista.

Reset Pan 
(Restablecer 
paneo)

Restablece el paneo de vista a su 
posición predeterminada.

View > Reset Pan (Ver > Restablecer paneo)

Pulse Mayús + N

Reset View 
(Restablecer vista)

Restablece la vista a su posición 
predeterminada.

View > Reset View (Ver > Restablecer vista)

Pulse Mayús + M

Reset Rotation 
(Restablecer 
rotación)

Restablece la rotación de vista a su 
posición predeterminada.

View > Reset Rotation (Ver > Restablecer 
rotación)

Pulse Mayús + X
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Comando Acción Métodos de acceso

Reset Zoom 
(Restablecer zoom)

Restablece el zoom de vista a su 
posición predeterminada.

View > Reset Zoom (Ver > Restablecer zoom)

Pulse Mayús + Z

Rotate View (Rotar 
vista)

Rota la vista  a la izquierda o a la 
derecha.

Mientras mantiene pulsado Ctrl + Alt 
(Windows) o ⌘  + Alt (macOS), haga clic y 
arrastre el disco de rotación para rotarlo a la 
derecha o a la izquierda.

3D Rotate View 
(Rotar vista 3D)

Rota la vista en cualquier dirección. 
Esta opción solo está disponible en la 
vista de escena, si la escena está 
habilitada en 3D.

Mientras mantiene pulsado Ctrl + Mayús 
(Windows) o mayúsculas + ⌘  (macOS), haga 
clic y arrastre la escena para rotarla en 
cualquier dirección.

Rotar 30 der.
Rota la vista de cámara 30 grados a la 
derecha, como una mesa de animación.

View > Rotate View CW (Ver > Rotar 30 
derecha)

Pulse V

Rotate 30 CCW 
(Rotar 30 izq.)

Rota la vista de cámara 30 grados a la 
izquierda, como una mesa de 
animación.

View > Rotate View CCW (Ver > Rotar 30 
izquierda)

Pulse C

Toggle Full Screen 
(Alternar pantalla 
completa)

Alterna entre hacer que la ventana 
principal de la aplicación se muestre en 
pantalla completa y restaurarla a su 
tamaño original.

View > Toggle Full Screen (Ver > Alternar 
pantalla completa)

Ctrl + Alt + Mayús + F (Windows) o ⌘  + Alt + 
mayúsculas + F (macOS)
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Capítulo 4: Adición de escenas y paneles

Capítulo 4: Adición de escenas y paneles
La estructura básica de un storyboard consta de escenas, y cada una de ellas está compuesta por uno o varios 
paneles. Un panel es un dibujo que representa una acción en el guion. Los paneles y las escenas de un 
storyboard se ordenan en orden cronológico, de izquierda a derecha.

Un proyecto de animación suele requerir la creación de una nueva escena cada vez que se necesita cambiar el 
layout. Esto significa que, por ejemplo, debe crear una nueva escena en el storyboard cada vez que un cambio 
en el ángulo de la cámara requiera que se utilice un dibujo o representación diferente del fondo, así como cada 
vez que el guion configure la acción de manera diferente.

Puede crear la estructura básica del storyboard al agregar una escena para cada escena que requiera el guion y, 
a continuación, al agregar un panel para cada acción en cada escena que debe representarse visualmente.

NOTA

En la terminología de acción en vivo, esta definición de escena se conoce como plano. Una escena 
de acción en vivo es en realidad una secuencia de planos que se producen en la misma 
configuración.

Si está trabajando en un storyboard destinado a una película de acción en vivo, puede hacer que 
Storyboard Pro utilice terminología de acción en vivo seleccionando la opción de estilo de 
terminología Live Action (Acción en vivo) en la pestaña General del cuadro de diálogo Preferences 
(Preferencias). Para facilitar la comprensión, esta guía utilizará principalmente la terminología de 
animación.

Creación de escenas
Un nuevo proyecto contendrá una escena con un solo panel en ella. La creación de una nueva escena siempre 
realizará automáticamente con un panel dentro.

Adición de una escena al storyboard

 1. Seleccione cualquier panel de la última escena del storyboard.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón New Scene  (Nueva escena).

 l Haga clic con el botón derecho en un panel y seleccione New Scene (Nueva escena).

 l En el menú superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo > 
Nueva escena).
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Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco.

Cada escena tiene un número asignado. Al crear una escena al final del proyecto, Storyboard Pro le asigna 
automáticamente el número que aparece justo después del número de la última escena. Si intenta insertar una 
escena entre dos escenas existentes, se le pedirá que indique cómo debe nombrarse esta nueva escena y si las 
escenas posteriores a la nueva deben volver a numerarse.

Inserción de una escena entre dos escenas existentes

 1. Seleccione cualquier panel de la escena después del cual se deba insertar la nueva escena.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón New Scene  (Nueva escena).

 l Haga clic con el botón derecho en un panel y seleccione New Scene (Nueva escena).

 l En el menú superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo > 
Nueva escena).

Aparece el cuadro de diálogo Rename Scene (Cambiar nombre de escena).
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Capítulo 4: Adición de escenas y paneles

 3. Realice una de las siguientes acciones:

 l Si desea que la nueva escena tenga un sufijo para indicar que se insertó entre las escenas 
existentes, no tiene que editar ninguno de los campos. El campo New name (Nuevo nombre) 
ya contiene el nombre de la escena seleccionada actualmente seguida de un sufijo de letra. 
Por ejemplo, si ha intentado insertar una escena antes de las escenas 2 y 3, Storyboard Pro 
nombrará la nueva escena 2_A de manera predeterminada.

 l Si desea que la escena tenga el número después del número de la escena seleccionada 
actualmente, y para volver a numerar todas las escenas siguientes en consecuencia, 
introduzca este número en el campo New Name (Nuevo nombre). Por ejemplo, si va a insertar 
una escena entre las escenas 2 y 3, escriba 3 en el campo New Name (Nuevo nombre). A 
continuación, en el menú desplegable Renaming Rule for Subsequent Scene (Regla de 
renombrar para la siguienta escena), seleccione Renumber Scenes (Volver a numerar 
escenas).

 4. Si tiene la intención de utilizar las mismas opciones cada vez que inserte una escena, marque la 
opción Do not show this dialog automatically (No mostrar este cuadro de diálogo 
automáticamente).

 5. Haga clic en OK (Aceptar).

Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco, 
numerado de acuerdo con la configuración seleccionada.

Creación de paneles
Un panel se utiliza para representar visualmente una acción en una escena. Debe agregar tantos paneles a una 
escena como sea necesario para describir explícitamente cada acción de esa escena.

Adición de un panel a una escena

 1. En la vista de imágenes en miniatura, seleccione el panel después del cual desea insertar un nuevo 
panel.
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 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón New Panel (Nuevo 
panel) .

 l Seleccione Storyboard > New > New Panel (Storyboard > Nuevo > Nuevo panel). 

 l Pulse P.

Se agrega un nuevo panel al storyboard y forma parte de la misma escena que el panel actual.

Creación de secuencias
Una secuencia es una forma de agrupar escenas. Su uso es opcional, pero pueden ayudarle a organizar el 
storyboard. Por ejemplo, puede utilizar secuencias para agrupar escenas que forman parte de la misma 
configuración.

Al comenzar a crear un storyboard, las escenas no formarán parte de ninguna secuencia de manera 
predeterminada. Para utilizar secuencias en el proyecto, puede seguir uno de los dos enfoques siguientes:

 l Después de haber creado todas las escenas que deben formar parte de la primera secuencia, 
simplemente utilice el comando New Sequence (Nueva secuencia) para crear la próxima escena. Todas 
las escenas que se encuentren en el proyecto se agruparán en la primera secuencia de este, y al final del 
proyecto se agregará una nueva escena que iniciará la segunda secuencia.

A partir de ese punto, puede utilizar el comando New Sequence (Nueva secuencia) cada vez que tenga 
que crear una escena que debe comenzar en otra secuencia.

 l Después de haber creado todas las escenas necesarias para el proyecto, puede dividir el storyboard en 
secuencias seleccionando las escenas que deben formar parte de la misma secuencia, agrupándolas en 
una nueva secuencia y repitiendo el proceso hasta que todas las escenas se encuentren en la secuencia 
adecuada.

Creación de una nueva secuencia

 1. Realice una de las siguientes acciones:
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 l En la barra de herramientas Storyboard, haga clic en el botón New Sequence (Nueva 
secuencia) .

 l Seleccione Storyboard > New > New Sequence (Storyboard > Nuevo > Nueva secuencia).

Se ha agregado una nueva escena al proyecto y ahora es el punto de inicio de una nueva secuencia.

Si esta es la primera secuencia que agrega a un proyecto, todas las escenas anteriores se 
combinarán en una secuencia independiente. Los marcadores de secuencia violetastambién serán 
visibles en las vistas de imágenes en miniatura y de línea de tiempo.

Creación de una nueva secuencia a partir de una selección

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione todas las escenas que desea 
colocar en una nueva secuencia. Para ello, mientras mantiene pulsado Mayús, haga clic en la primera 
escena para que forme parte de la nueva secuencia y, a continuación, haga clic en la última escena 
con el mismo propósito. Con esta acción se selecciona cada escena entre las escenas en las que hizo 
clic.

 2. Realice una de las siguientes acciones:

 a. En el menú superior, seleccione Storyboard > New > New Sequence from Selection 
(Storyboard > Nuevo > Nueva secuencia a partir de selección).

 b. Haga clic con el botón derecho en la selección y, a continuación, seleccione New Sequence 
from Selection (Nueva secuencia a partir de selección).

La selección se convierte en una nueva secuencia.

Si esta es la primera secuencia que agrega al proyecto, todas las escenas anteriores a la selección se 
agruparán en una secuencia independiente, y todas las escenas posteriores a la selección se 
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agruparán en otra secuencia. Los marcadores de secuencia violetas serán visibles en las vistas de 
imágenes en miniatura y de línea de tiempo.

NOTA

Las secuencias deben incluir escenas completas. Dos paneles en la misma escena no pueden 
formar parte de distintas secuencias.

Reordenación de paneles
Puede reordenar paneles haciendo clic en el controlador de arrastrar y colocar  situado en la esquina superior 
izquierda del panel y, a continuación, arrastrando el panel entre los dos paneles donde desea que se muevan. 
Aparecerá una línea roja entre los dos paneles cerca del cursor del ratón para indicar el lugar al que se moverá el 
panel.
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CONSEJO

Si desea mover varios paneles a la vez, puede seleccionarlos, hacer clic y arrastrar el controlador de 
arrastrar y colocar de cualquier panel de la selección. Para seleccionar varios paneles en la vista de 
imágenes en miniatura, realice una de las siguientes acciones:

 l Dibuje un rectángulo en la vista de imágenes en miniatura alrededor de todos los paneles que 
desee seleccionar.

 l Mientras mantiene pulsado Mayús, haga clic en el primer panel que desee agregar a la selección 
y, a continuación, en el último panel que desee agregar a la selección. Todos los paneles 
intercalados también se seleccionarán.

 l Mientras mantiene pulsado Ctrl (Windows) o ⌘  (macOS), haga clic en cada panel que desee 
agregar a la selección.

Si mueve un panel al espacio situado entre dos escenas, tiene la opción de colocar el panel en la escena anterior 
o posterior a este espacio, o de colocarlo en su propia escena nueva. El lugar donde terminará la escena 
dependerá de lo cerca que coloque el panel. La línea roja que aparece entre las dos escenas indicará si se 
colocará en la escena anterior o posterior al espacio en el que se vaya a colocar el panel o si se moverá a su 
propia escena nueva.
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Capítulo 5: Importación de un guion y adición de 
leyendas
La creación de un storyboard comienza con la escritura del guion para el proyecto. En Storyboard Pro, puede 
importar el guion en el proyecto. A continuación, puede almacenar cada parte del guion en su panel de 
storyboard correspondiente para proporcionar al artista del storyboard la información necesaria para dibujar los 
paneles.

De forma predeterminada, cada panel puede almacenar cuatro tipos diferentes de leyendas: Dialogue (Diálogo), 
Action Notes (Notas de acción), Slugging y Notes (Notas). Las Dialogue (Diálogo) y Action Notes (Notas de 
acción) se pueden obtener directamente del guion, y Notes (Notas) se puede utilizar para almacenar 
información como encabezados de escenas, transiciones y otra información útil.

Las leyendas de Slugging se suelen agregar más tarde, mientras se crea el storyboard, para proporcionar 
indicaciones de tiempo sobre los diálogos y acciones para la animática.

Importación de un guion
Puede importar un guion en texto sin formato (.txt), formato de texto enriquecido (.rtf) o en un archivo XML de 
Final Draft (.fdx) directamente en el campo Script (Guion) de la vista de storyboard. También puede copiar y 
pegarlo desde el editor, o escribirlo directamente en la vista de storyboard.

Importación de un guion en un proyecto de Storyboard Pro

 1. En la vista de storyboard, haga clic en el botón Caption Menu (Menú de cuadro de texto)  y:

 l Si el guion está en texto sin formato (.txt) o en formato de texto enriquecido (.rtf), seleccione 
Import Caption (Importar cuadro de texto).

 l Si el guion está en un formato XML de Final Draft (.fdx), seleccione Import Final Draft Script 
(Importar guion de Final Draft).

 2. En el buscador de archivos, localice y seleccione el archivo de guion y haga clic en Open (Abrir).

El guion aparece en el campo de cuadro de texto Script (Guion).
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Adición de leyendas
Una vez importado el guion, puede crear la estructura básica del storyboard creando escenas y paneles vacíos 
en función de los encabezados de escenas, acciones y diálogos del guion, y rellenando los campos de leyenda de 
cada panel del storyboard con información del guion.

Para ello, puede seleccionar un fragmento del guion en la vista de storyboard y, a continuación, puede 
arrastrarlo y colocarlo en un campo de leyenda en la vista de panel, copiando al instante el texto seleccionado 
en el campo de leyenda del panel actual.

NOTA

Para aprender a crear escenas y paneles, consulte Adición de escenas y paneles en la página 24.

Cómo arrastrar y colocar texto desde el guion en campos de cuadro de texto

 1. Cambie a la zona de trabajo vertical haciendo lo siguiente:

 l En la barra de herramientas Workspace (Zona de trabajo), haga clic en el botón Vertical 
Workspace  (Zona de trabajo vertical).

 l En el menú superior, seleccione Windows > Workspace > Vertical (Ventanas > Zona de 
trabajo > Vertical).
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 2. En el panel derecho de la zona de trabajo, seleccione la pestaña Storyboard.

La zona de trabajo tiene ahora una lista vertical de cada panel del storyboard a la izquierda, con sus 
campos de cuadro de texto correspondientes en el centro y el guion del storyboard a la derecha.

 3. En la vista de imágenes en miniatura, desplácese al panel en el que desee agregar cuadros de texto.

 4. En el campo de cuadro de texto Script (guion) de la vista de storyboard, seleccione la parte del guion 
que desea agregar a un cuadro de texto del panel.

 5. En el cuadro de texto Script (Guion), arrastre el texto seleccionado y colóquelo en el campo de cuadro 
de texto adecuado del panel.

 6. Repítalo hasta que haya copiado todo el texto necesario para cada uno de los paneles en sus campos 
de cuadro de texto.

 7. Una vez que haya terminado, puede restaurar la zona de trabajo que estaba utilizando 
seleccionándola desde la barra de herramientas Workspace (Zona de trabajo) o desde el menú 
superior, en Windows > Workspace (Ventanas > Zona de trabajo).
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NOTA

También puede arrastrar y colocar texto desde cualquier cuadro de texto del panel a otro 
cuadro de texto del panel, o desde un cuadro de texto del panel al guion.

Creación de un proyecto a partir de un guion de Final Draft
Si el guion se ha escrito en Final Draft, puede generar automáticamente un proyecto con escenas, paneles 
vacíos y títulos rellenados previamente basados en la estructura del guion. Por ejemplo, puede generar un 
proyecto con una nueva escena para cada encabezado de escena y un nuevo panel para cada acción o diálogo, 
y almacenar el contenido de estos párrafos en los campos de leyenda de sus paneles, lo que le permite iniciar el 
proceso de creación de storyboard.

Creación de un proyecto a partir de un guion de Final Draft

 1. En el menú superior, seleccione File > New From Final Draft Script (Archivo > Nuevo desde guion 
de Final Draft).

Se abre el cuadro de diálogo Import from Final Draft (Importar desde Final Draft).

 2. Haga clic en el botón Browse (Examinar) .

 3. en el buscador de archivos, localice y seleccione el guion de Final Draft y haga clic en Open (Abrir).

Una vez cargado el guion, los tipos de etiquetas que figuran en el guion aparecerán en la lista de la 
izquierda. Tendrá que indicar a Storyboard Pro qué hacer con cada una de estas etiquetas al 
generar el proyecto.
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 4. En la lista de la izquierda, seleccione Scene Heading (Encabezado de escena):

 a. En la lista desplegable Action (Acción), seleccione New Scene.

 b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 
seleccione Notes (Notas).

El storyboard dispondrá de una escena para cada encabezado de escena del guion, y la descripción 
de la escena se agregará a la leyenda Notes (Notas) al primer panel de cada escena.

 5. En la lista de la izquierda, seleccione la etiqueta Action (Acción).

 a. Si desea que se cree un panel para cada acción, seleccione New Panel (Nuevo panel) en la 
lista desplegable Action (Acción).

 b. Si desea combinar acciones consecutivas en el mismo panel, marque la opción Combine 
successive elements (Combinar elementos sucesivos).

 c. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 
seleccione Action Notes (Notas de acción). Esta acción almacenará el contenido de la etiqueta 
de acción en la leyenda Action Notes (Notas de acción) de cada panel. 

 6. En la lista de la izquierda, seleccione la etiqueta Character (Personaje), si la hubiera:

 a. Si desea que se cree un panel para cada diálogo, seleccione New Panel (Nuevo panel) en la 
lista desplegable Action (Acción).

 b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 
seleccione Dialogue (Diálogo).

 7. En la lista de la izquierda, seleccione la etiqueta Parenthetical (Explicación), si la hubiera:

 a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 
seleccione Dialogue (Diálogo).
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 8. En la lista de la izquierda, seleccione la etiqueta Dialogue (Diálogo), si la hubiera:

 a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino), 
seleccione Dialogue (Diálogo). 

 9. En la lista de la izquierda, seleccione la etiqueta Transition (Transición), si la hubiera:

 a. En la lista desplegable Action (Acción), seleccione New Transition (Nueva transición). 

En general, se sugieren las siguientes configuraciones:

  Acción
Campo de cuadro de texto 
de destino

Action (Acción)
New Panel (Nuevo panel) o 
None (Ninguno)

Notas de acción

Character (Personaje)
New Panel (Nuevo panel) o 
None (Ninguno)

Diálogo

Diálogo Ninguno Diálogo

Parenthetical (Explicación) Ninguno Diálogo

Scene Heading (Encabezado 
de escena)

New Scene (Nueva escena) Notas

Transición Nueva transición Ninguno

Dependiendo de la forma en la que esté estructurado el guion y del ritmo de la acción o el 
diálogo, es posible que tenga que intentar crear un proyecto con el guion utilizando distintas  
opciones para obtener la mejor estructura de storyboard según sus necesidades. Al final, es 
probable que tenga que dividir o combinar algunos de los paneles generados 
automáticamente.

 10. Si desea que los parámetros seleccionados actualmente sean predeterminados, marque la casilla de 
verificación Save as default rules (Guardar como reglas predeterminadas).

 11. Haga clic en Import (Importar).

 12. En el cuadro de diálogo New Project (Nuevo proyecto), introduzca el nombre, la ubicación, el título y 
la resolución del proyecto.

 13. Si el proyecto abierto actualmente no se ha guardado, confirme si desea guardarlo.
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Se crea su nuevo proyecto con escenas y paneles creados automáticamente y sus leyendas llenas de 
fragmentos del guion en función de la configuración que haya seleccionado.

38



39

Guía de introducción de Storyboard Pro 6



Capítulo 6: Adición y gestión de capas

Capítulo 6: Adición y gestión de capas
Cada panel del storyboard puede estar compuesto por una o varias capas de dibujo. Esas capas se componen 
juntas para realizar el dibujo en cada panel.

Tipos de capa
Storyboard Pro admite cuatro tipos de capas: capas de dibujo de vectores, capas de dibujo de mapa de bits, 
capas 3D y grupos.

 l Vector Layers (Capas de vectores): Los dibujos de vectores están formados por puntos y curvas que 
componen los contornos de las formas de la ilustración, junto con el color o las texturas de relleno. Por lo 
tanto, la ilustración en capas de vectores se pueden escalar y ampliar sin que pierdan calidad, a menos 
que contengan una textura.

Al dibujar en una capa de vector, cada línea vectorial transparente de dibujo y cada línea de lápiz es un 
objeto independiente que puede manipularse por separado. Puede seleccionar líneas vectoriales 
transparentes y, a continuación, moverlas y transformarlas, incluso si se aplicaron líneas vectoriales 
transparentes de dibujo sobre ellas. Además, debido a que las líneas vectoriales transparentes de dibujo 
están formadas por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y los 
cambios en la ilustración.

 l Bitmap Layers (Capas de mapa de bits): Los dibujos de mapa de bits se componen de una cuadrícula de 
píxeles, que son puntos pequeños que tienen un solo color sólido. Las herramientas de dibujo de mapa de 
bits permiten colocar líneas vectoriales transparentes de pincel en un único lienzo plano y ajustar la 
ilustración píxel a píxel si es necesario.
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Al dibujar en una capa de mapa de bits, cada línea vectorial transparente se compone en el lienzo, por lo 
que continúa siendo un dibujo único que solo se puede pintar o borrar, pero que no permite ajustar partes 
individuales de él.

Las ilustraciones de mapas de bits solo se pueden escalar o ampliar tanto como lo permita su densidad de 
píxeles sin perder calidad de imagen. De forma predeterminada, la ilustración de mapa de bits tiene una 
densidad de píxeles del 100 %, que solo es suficiente para mostrar la ilustración sin ampliarla o escalarla; 
de lo contrario, Storyboard Pro debe generar nuevos píxeles en la ilustración, lo que puede hacer que se 
vea borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de píxeles requerida para la ilustración de mapa 
de bits, en función de si tendrá que ampliarla o escalarla, antes de comenzar a dibujar en una capa de 
mapa de bits.

 l 3D Layers (Capas 3D): Cuando importe un modelo 3D en la librería, si lo agrega a un panel, se 
almacenará el modelo en una capa 3D. A continuación, puede manipular y animar el modelo 3D, al igual 
que con una capa de dibujo.

 l Group (Grupo): Un grupo puede contener varias capas de cualquier tipo. Al igual que puede transformar 
y animar una capa, también puede transformar y animar un grupo. Las transformaciones y animaciones 
aplicadas a un grupo afectarán a todas las capas del grupo simultáneamente.

La forma más fácil de gestionar capas en un panel es utilizar el panel Layer (Capa) en las vistas de escena y de 
cámara. Sin embargo, también se puede agregar la vista de capas al espacio de trabajo, que funciona de la 
misma manera y cuenta con una función adicional. A continuación, puede ocultar el panel Layer (Capa) haciendo 
clic en su botón Collapse (Contraer) , situado en su esquina superior izquierda, para dejar más espacio para 
trabajar en las vistas de escena y de cámara.
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También puede gestionar capas utilizando la vista de imágenes en miniatura. Cada panel tiene una lista vertical 
de capas en su borde derecho que le permite desplazarse por ellas y seleccionarlas. A la izquierda de la vista de 
imágenes en miniatura, debajo de la barra de herramientas Tools (Herramientas), se encuentra una barra de 
herramientas Layer (Capa), que le permite agregar y eliminar capas al o del panel seleccionado.

Adición de capas
De forma predeterminada, un panel contiene un fondo (BG) y una capa de dibujo (A), pero puede agregar 
tantas capas como necesite a cada panel del proyecto.

Adición de una capa a un panel

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione el panel al que desea agregar 
una nueva capa.
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 2. En el panel Layer (Capa) de la vista de escena o de cámara, de la vista de capas o de la vista de 
imágenes en miniatura, seleccione la capa sobre la que desea crear una nueva capa.

 3. Realice una de las siguientes acciones:

 l Haga clic en el botón Add Vector Layer (Agregar capa de vector)  o Add Bitmap 
Layer (Agregar capa de mapa de bits) . Estos botones se encuentran en la parte 
inferior del panel Layer (Capa) en las vistas de escena y de cámara, en la parte inferior 
de la vista de capas y en la barra de herramientas Layer (Capa).

 l En el menú superior, seleccione Layer > New > Vector Layer (Capa > Nueva > Capa de 
vector) o New Bitmap Layer (Nueva capa de mapa de bits).

Eliminación de capas
Puede eliminar capas que no necesite para evitar abarrotar la lista de capas.

Eliminación de una capa de un panel

 1. En el panel Layer (Capa) de la vista de escena o de cámara, de la vista de capas o de la vista de 
imágenes en minuatura, seleccione la capa que desea eliminar.

 2. Realice una de las siguientes acciones:

 l Haga clic en el botón Delete Selected Layers (Eliminar capas seleccionadas) . Este 
botón se encuentra en la parte inferior del panel Layer (Capa) en las vistas de escena y 
de cámara, en la parte inferior de la vista de capas y en la barra de herramientas Layer 
(Capa).

 l Haga clic con el botón derecho en la capa y seleccione Delete Layers (Eliminar capas).

 l En el menú superior, seleccione Layer > Delete Layers (Capa > Eliminar capas).

Agrupación de capas
Puede agrupar las capas para facilitar su gestión, o si desea transformar y animar varias capas a la vez.

Agrupación de capas

 1. En el panel Layer (Capa) de la vista de escena o de cámara o en la vista de capas, seleccione al 
menos dos capas que desee agrupar.

 2. Realice una de las siguientes acciones:
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 l Haga clic en el botón Group Selected Layers (Agrupar capas seleccionadas) . Este botón se 
puede encontrar en la parte inferior del panel Layer (Capa) en la vista de escena o de cámara 
y en la parte inferior de la vista de capas.

 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Group Selected 
Layers (Agrupar capas seleccionadas).

 l En el menú superior, seleccione Layer > Group Selected Layers (Capa > Agrupar capas 
seleccionadas).

CONSEJO

Puede arrastrar y colocar capas dentro o fuera de grupos.

Visualización y ocultación de capas
Al trabajar con muchas capas, puede ocultar temporalmente determinadas capas para evitar abarrotar la 
escena.

También puede ocultar un grupo. Al ocultar un grupo, todas las capas que contiene aparecen ocultas, pero se 
conserva su estado de visibilidad individual. Por lo tanto, si oculta solo algunas capas de un grupo, oculte el 
grupo y, a continuación, muéstrelo. Así, las capas que se ocultaron individualmente permanecerán ocultas, y las 
que estaban visibles se volverán a ver.

Cómo mostrar u ocultar una capa

 1. Realice una de las siguientes acciones:
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 l En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Show/Hide Layer 
(Mostrar/ocultar capa)  justo a la izquierda de la capa.

 l En la vista de imágenes en miniatura, haga clic en el icono Show/Hide Layer (Mostrar/ocultar 
capa)  justo debajo del nombre de la capa.

 l En el panel Layer (Capa), la vista de capas o la vista de imágenes en miniatura, haga clic con el 
botón derecho en la capa y seleccione Show/Hide Layers (Mostrar/ocultar capas).

 l En el panel Layer (Capa), la vista de capas o la vista de imágenes en miniatura, seleccione la 
capa y, a continuación, seleccione Layer > Show/Hide Layers (Capa > Mostrar/ocultar capas) 
en el menú superior.

Bloqueo y desbloqueo de capas
Puede bloquear una capa seleccionada con el fin de proteger los objetos que contenga para impedir que se 
cambien. Una vez bloqueada, puede desbloquearla para realizar cambios en cualquier objeto de la misma.

Bloqueo o desbloqueo de una capa

 1. Realice una de las siguientes acciones:

 l En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Lock/Unlock 
(Bloquear/desbloquear)  justo a la izquierda de la capa.

 l En la vista de imágenes en miniatura, haga clic en el icono Lock/Unlock 
(Bloquear/desbloquear)  justo debajo del nombre de la capa.

 l En el panel Layer (Capa), en la vista de capas o la vista de imágenes en minuatura, seleccione 
la capa. A continuación, realice una de las siguientes acciones:

 l Después, seleccione Layer > Lock/Unlock Layers (Capa > Bloquear/desbloquear capas) 
en el menú superior.

 l En la barra de herramientas Layer (Capa), haga clic en el botón Lock/Unlock Layers 
(Bloquear/desbloquear capas) .

 l Pulse Alt + L.

45

Guía de introducción de Storyboard Pro 6



Capítulo 7: Cómo dibujar y pintar

Capítulo 7: Cómo dibujar y pintar

Cómo dibujar
Al crear un nuevo proyecto en Storyboard Pro, puede comenzar a dibujar inmediatamente en el panel 
seleccionado utilizando una de las herramientas de dibujo a su disposición.

Cómo dibujar

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione el panel en el que desea 
dibujar.

 2. En el panel Layer (Capa) de la vista de escena, seleccione la capa sobre la que desea dibujar.

 3. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) 
.

 l En el menú superior, seleccione Tools > Brush (Herramientas > Pincel).

 l Pulse Alt + B.

 4. En la vista de color, realice una de las siguientes acciones para seleccionar un color:

 l Utilice los controles deslizantes Hue (Matiz), Saturation (Saturación) y Value (Valor) para 
seleccionar el color con el que desea dibujar.

 l Seleccione una muestra de color de la lista de muestras.
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CONSEJO

Si desea guardar el color para poder volver a utilizarlo más tarde, haga clic en el botón 
Add Colour (Agregar color)  en la vista de color para guardar el color en una nueva 
muestra de color.

 5. En la vista de escena, comience a dibujar.

CONSEJO

Puede rotar la vista de escena para poder dibujar en un ángulo con el que se sienta más 
cómodo. Para ello, mantenga pulsado Ctrl + Alt (Windows) o ⌘  + Alt (macOS) y, a 
continuación haga clic y arrastre el disco de animación para rotarlo a la derecha o a la izquierda. 

Para restablecer la vista a su ángulo original, puede realizar una de las siguientes acciones:

 l En la barra de estado de la vista de escena, haga clic en el icono Reset Rotation 
(Restablecer rotación) .

 l En el menú superior, seleccione View > Reset Rotation (Ver > Restablecer rotación).

 l Pulse Mayús + Z.

Cómo pintar
También puede pintar los dibujos para obtener un aspecto más acabado. Puede pintar los personajes y props 
con sus esquemas de color, o simplemente rellenarlos de blanco para que sus contornos no se mezclen con el 
fondo.

Cómo pintar un dibujo

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) 
.

 l En el menú superior, seleccione Tools > Paint (Herramientas > Pintar).

 l Pulse Alt+I.

 2. En la vista de color, realice una de las siguientes acciones para seleccionar un color:

 l Utilice los controles deslizantes Hue (Matiz), Saturation (Saturación) y Value (Valor) para 
seleccionar el color con el que desea dibujar.

 l Seleccione una muestra de color de la lista de muestras.
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CONSEJO

Si desea guardar el color para poder volver a utilizarlo más tarde, haga clic en el botón 
Add Colour (Agregar color)  en la vista de color para guardar el color en una nueva 
muestra de color.

 3. En la vista de escena, empiece a pintar en el dibujo haciendo clic en el área que desea pintar. Si 
desea rellenar varias áreas al mismo tiempo, dibuje un lazo alrededor de ellas.

NOTA

Si la forma que está tratando de pintar no está completamente cerrada, no se rellenará. 
Puede hacer que la herramienta Paint (Pintar) cierre automáticamente pequeños huecos 
en las formas que intenta rellenar aumentando la configuración Close Gap (Cerrar 
hueco)  de la herramienta Paint (Pintar) en la vista de propiedades de la herramienta. 
Para cerrar huecos grandes, puede utilizar la herramienta Close Gap (Cerrar hueco) , 
disponible en el menú emergente de la herramienta Paint (Pintar)  en la barra de 
herramientas Tools (Herramientas).
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Estilos artísticos, herramientas de dibujo y tipos de capas
En las capas de vectores, es posible dibujar con líneas de lápiz, pinceles de vectores y pinceles de mapa de bits 
con textura. Mientras que las líneas de lápiz son meramente líneas centrales de vectores a las que Storyboard 
Pro agrega el grosor, las líneas vectoriales transparentes de pincel son formas de vector sólidas rellenas con un 
color, y las líneas vectoriales transparentes de pincel con textura son regulares y rellenas con una textura de 
mapa de bits que filtra su color.

En las capas de mapa de bits, solo puede dibujar utilizando pinceles de mapa de bits sólidos o con textura. Por lo 
tanto, aunque las capas de vectores son más flexibles porque permiten manipular y ajustar fácilmente partes de 
la ilustración, también pueden albergar más estilos artísticos.

Sin embargo, si utiliza un pincel con textura en una capa de vectores, las líneas vectoriales transparentes de 
pincel tendrán una textura de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa 
de bits, intentar ajustar o cambiar el tamaño de una línea vectorial transparente de pincel con textura requerirá 
que Storyboard Pro vuelva a probar la textura, lo que puede hacer que pierda calidad de imagen, a menos que 
su resolución de textura se hubiera aumentado lo suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los 
dibujos de mapa de bits siempre están hechos de un solo lienzo plano, las líneas vectoriales transparentes de 
pincel de vectores se guardan como objetos independientes. Esto significa que colocar muchas líneas vectoriales 
transparentes de pincel con textura en un dibujo de vectores requerirá que Storyboard Pro almacene la textura 
para cada una de estas pinceladas y las una en tiempo real para mostrar el dibujo. Esto puede hacer que los 
dibujos de vectores con textura gruesa, a diferencia de los dibujos de mapa de bits, hagan que el rendimiento de 
la aplicación sea más lento y el tamaño del archivo sea más pesado. Sin embargo, este es el único caso en el que 
es probable que un dibujo de vectores sea más pesado que un dibujo de mapa de bits.
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NOTA

Incluso si aplana la ilustración, las líneas vectoriales transparentes de pincel con textura de distintos 
colores no se pueden aplanar a la vez en las capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Storyboard Pro:

Herramienta de 
dibujo

Tipo de 
capa

 

Lápiz Vector

Ventajas: muy ligero y fácil de ajustar. Puede manipularse, volver a 
colocarse y ajustarse mediante la línea central. Se puede ampliar o alejar sin 
perder calidad.

Desventajas: no admite texturas. No está optimizado para la transparencia.

Uso recomendado: bocetos, dibujos limpios con un estilo de contorno 
sólido y uniforme.

Pincel de vectores 
sólido

Vector

Ventajas: tamaño de archivo ligero. Reproduce el estilo de animación 
tradicional. Puede manipularse, volver a colocarse y editarse mediante el 
contorno o la línea central. Se puede ampliar o alejar sin perder calidad.

Desventajas: no se puede reproducir el aspecto de los medios naturales.

Uso recomendado: bocetos, dibujos limpios de estilo de animación 
tradicional.

Pincel de vectores 
con textura

Vector

Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta 
con las mismas capacidades que los pinceles de mapa de bits con textura, 
pero puede manipularse, editarse y volver a colorearse como un pincel de 
vectores sólido.

Desventajas: las líneas vectoriales transparentes superpuestas pueden 
hacer que el dibujo haga que el rendimiento de la aplicación sea lento y el 
tamaño de los archivos sea pesado. Las líneas vectoriales transparentes de 
distintos colores no se pueden aplanar a la vez. Ajustar, escalar o ampliar la 
ilustración puede hacer que pierda calidad de textura.

Uso recomendado: para ilustraciones con textura de estilo de mapa de bits 
ligero o ilustraciones de estilo mixto.

Pincel de mapa de 
bits con textura

Mapa de 
bits

Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor 
rendimiento y tamaño de archivo más ligero que las ilustraciones de 
vectores con texturas gruesas. Se puede editar píxel a píxel.

Desventajas: las líneas vectoriales transparentes siempre se aplanan a la vez 
y no se pueden modificar por separado. Solo se pueden dibujar o borrar. 
Escalar o ampliar la ilustración puede hacer que pierda calidad de imagen.
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Herramienta de 
dibujo

Tipo de 
capa

 

Uso recomendado: ilustración de mapa de bits con textura gruesa.
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Capítulo 8: Creación de una animática
Una vez creado el storyboard, el siguiente paso es convertirlo en una animática. Una animática es básicamente 
un vídeo que reproduce cada panel del storyboard. Cada panel debe programarse para que coincida con el 
tiempo previsto de las acciones, y cada escena debe programarse para que coincida con el ritmo previsto de la 
historia. Los movimientos de la cámara se pueden animar para simular cómo se verá la acción en relación con los 
movimientos y el encuadre de la cámara. Las capas del storyboard también se pueden animar para que la acción 
y el tiempo se puedan leer con más facilidad.

Se pueden agregar efectos de sonido, clips de voz y pistas de música, ya sean provisionales o finales, para 
marcar el ritmo de la acción, así como para hacer un borrador de la mezcla de sonido para el producto final. A la 
animática también se pueden agregar vídeos e imágenes fijas, como secuencias de apertura o finalización, 
superposiciones, leyendas, logotipos o imágenes de acción en vivo, para utilizarlos como referencias o para que 
no se tengan que crear bocetos en paneles.

En Storyboard Pro, puede crear una animática desde el storyboard utilizando la vista de línea de tiempo. La 
vista de línea de tiempo se parece mucho a la línea de tiempo de un software de edición de vídeos. Entre otras 
cosas, permite ajustar visualmente el tiempo de cada panel, importar, preparar y recortar los clips de sonido y de 
vídeo, animar los movimientos de la cámara, animar capas y agregar transiciones entre escenas. Por lo tanto, le 
acompañará en cada paso hacia la creación de la animática.

La primera vez que abra la vista de línea de tiempo después de crear un storyboard, observará que todos los 
paneles del storyboard ya se encuentran en la pista y cronometrados para que duren un segundo cada uno. Por 
lo tanto, el storyboard ya es une animatica basica, y ya puede comenzar a ajustar la longitud de cada panel para 
que coincida con el tiempo previsto de las acciones y el ritmo previsto de las escenas.

Al final, una animática se puede exportar a archivos de vídeo o incluso a escenas de Toon Boom Harmony. 
Consulte Exportación del proyecto en la página 86.
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Acceso a la vista de línea de tiempo

 1. Realice una de las siguientes acciones:

 l En la esquina superior derecha de la vista de la vista de imágenes en miniatura, haga clic en el 
botón Add View (Agregar vista)  y seleccione Timeline (Línea de tiempo).

 l Seleccione Windows > Timeline (Ventanas > Línea de tiempo).

Configuración de la duración del panel
Existen varias formas de establecer la duración de un panel. La vista de panel permite escribir la duración 
exacta del panel actual. La vista de línea de tiempo permite ampliar o reducir paneles visualmente. También 
puede ajustar la duración de un panel utilizando los atajos de teclado Add Frame to Panel (Agregar fotograma a 
panel) y Remove Frame to Panel (Eliminar fotograma de panel).

Configuración de la duración del panel en la vista de panel

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione un panel.

 2. En la vista de panel, realice una de las siguientes acciones:

 l En el campo Duration (Duración), escriba la longitud exacta deseada para el panel, en el 
formato H:MM:SS:FF, donde H significa horas, M significa minutos, S significa segundos y F 
significa fotogramas.

 l A la derecha del campo Duration (Duración), haga clic en la flecha arriba  para ampliar el 
panel en un fotograma, o haga clic en la flecha abajo  para acortar el panel en un fotograma.

Ajuste de la longitud de un panel en la vista de línea de tiempo y ondulación de paneles 
siguienta

 1. Coloque el cursor sobre el borde derecho del panel cuyo tamaño desea cambiar.

Se muestra el icono de cambio de tamaño.
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 2. Haga clic y arrastre el borde del panel hacia la derecha para extenderlo o hacia la izquierda para 
reducirlo. A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que 
está agregando o restando del mismo.

Todos los paneles posteriores se desplazaran hacia delante o hacia atrás para conservar su longitud.

Cambio de tamaño de un panel sin compensar paneles posteriores y cambio de tamaño 
solo del siguiente panel

 1. Coloque el cursor sobre el borde derecho del panel cuyo tamaño desea cambiar.

Se muestra el icono de cambio de tamaño.

 2. Mientras mantiene pulsada la tecla Alt, haga clic y arrastre el borde del panel hacia la derecha para 
extenderlo o hacia la izquierda para reducirlo. A medida que lo arrastra, se indica la nueva longitud 
del panel y la cantidad de tiempo que está agregando o restando del mismo.
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La longitud del siguiente panel se ajustará para evitar el desplazamiento de paneles posteriores.

Ajuste de la duración del panel fotograma a fotograma

 1. En la vista de línea de tiempo o de imágenes en miniatura, seleccione un panel.

 2. Realice una de las siguientes acciones:

 l Pulse + para agregar un fotograma al panel, o - para eliminar un fotograma del panel.

 l En el menú superior, seleccione Storyboard > Add Frame to Panel (Storyboard > Agregar 
fotograma a panel) o Storyboard > Remove Frame from Panel (Storyboard > Eliminar 
fotograma de panel).

Animación de capas
De forma predeterminada, las capas de Storyboard Pro son estáticas, pero se pueden animar.

Una capa se anima mediante su configuración en distintas posiciones, ángulos o tamaños en dos fotogramas 
diferentes en la línea de tiempo y, a continuación, permitiendo que Storyboard Pro calcule la posición, el ángulo 
y el tamaño de la capa de cada fotograma entre esos dos fotogramas. Los fotogramas al principio y al final de 
una animación se conocen como fotogramas clave.

Puede animar una capa habilitando la animación en ella, acción que creará un fotograma clave en su posición 
actual en el fotograma actual. A partir de ahí, puede ir a otro fotograma y cambiar su posición, acción que creará 
automáticamente otro fotograma clave en el fotograma actual. En este punto, la capa ya está animada desde su 
posición original hasta la posición en la que la acaba de mover.

Animación de una capa

 1. En la vista de línea de tiempo, seleccione el panel con la capa que desea animar.

 2. Mueva el cursor de la línea de tiempo al momento exacto en el que desea crear el primer fotograma 
clave de la animación.

 3. En el panel Layer (Capa) de la vista de escena o de cámara, haga clic en el botón Animate (Animar) 
de la capa que desea animar.
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El botón Animate (Animar) se vuelve amarillo y cambia de forma: .

En la pista de animación de capa de la vista de línea de tiempo se crea un fotograma clave en el 
fotograma actual. Este fotograma clave almacena la posición, el ángulo y el tamaño de la capa en el 
fotograma actual.

 4. En la barra de herramientas Tools (Herramientas), haga clic en el botón Layer Transform 
(Transformación de capas) .

En la vista de escena o de cámara aparece un cuadro de manipulador alrededor del dibujo en la capa 
que está animando.
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 5. Utilizando el cuadro del manipulador, transforme la capa para que tenga la posición, el ángulo y el 
tamaño que desee que tenga al comienzo de la animación:

 l Para mover la capa, haga clic en la ilustración o en el punto azul en el centro y arrástrela a la 
posición deseada.

 l Para escalar la capa, haga clic en uno de los cuadrados de los bordes o esquinas del cuadro del 
manipulador y arrástrelo para estirar o contraer el dibujo.

CONSEJO

Puede mantener pulsada la tecla Mayús mientras escala un dibujo para conservar 
sus proporciones.

 l Para rotar la capa, mueva el cursor fuera de una de las esquinas del cuadro del manipulador 
hasta que el cursor del ratón se convierta en . A continuación, haga clic y arrastre en 
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cualquier dirección para rotar la capa a la derecha o a la izquierda.

 

 6. En la vista de línea de tiempo, mueva el cursor al fotograma en el que desea crear el segundo 
fotograma clave.

 7. En la vista de escena o de cámara, utilice el cuadro del manipulador para transformar la capa de 
modo que tenga la posición, el ángulo y el tamaño que desea que tenga al final de la animación.

Se crea un fotograma clave en el fotograma actual cuando realice la primera transformación.

 8. Desplace el cursor de la línea de tiempo al principio del panel.

 9. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir)  para 
obtener una vista previa de la animación.

Animación de la cámara
Para crear movimiento de la cámara en una escena, debe comenzar creando al menos dos fotogramas clave de 
la cámara y, a continuación, establecer la posición de la cámara en cada uno de esos fotogramas clave. 
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Storyboard Pro interpolará la posición de la cámara en cada fotograma entre dos fotogramas clave.

Animación de la cámara en una escena

 1. Seleccione la herramienta Camera (Cámara) realizando una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Camera 
(Cámara) .

 l En el menú superior, seleccione Tools > Camera (Herramientas > Cámara).

 2. En la vista de línea de tiempo, haga clic y arrastre el cursor de la línea de tiempo hasta el fotograma 
en el que desea que comience el movimiento de la cámara.

 3. Cree un fotograma clave de cámara realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, en la columna izquierda de la pista de cámara, haga clic en el 
botón Add Keyframe (Agregar fotograma clave) .

 l En el menú superior, seleccione Camera > Add Camera Keyframe at Current Frame (Cámara 
> Agregar fotograma clave de cámara en el fotograma actual).

 l En la vista de propiedades de la herramienta, haga clic en el botón Add Keyframe (Agregar 
fotograma clave)  del panel Camera Transform (Transformación de cámara).

Se agrega un fotograma clave en la pista de cámara de la vista de línea de tiempo donde se 
encuentre el cursor de la línea de tiempo.

 4. En la vista de línea de tiempo, haga clic y arrastre el cursor de la línea de tiempo hasta el fotograma 
en el que desea que finalice el movimiento de la cámara.

 5. Cree un fotograma clave de cámara realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, en la columna izquierda de la pista de cámara, haga clic en el 
botón Add Keyframe (Agregar fotograma clave) .

 l En el menú superior, seleccione Camera > Add Camera Keyframe at Current Frame (Cámara 
> Agregar fotograma clave de cámara en el fotograma actual).

 l En la vista de propiedades de la herramienta, haga clic en el botón Add Keyframe (Agregar 
fotograma clave)  del panel Camera Transform (Transformación de cámara).
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Se agrega otro fotograma clave en la pista de cámara de la vista de línea de tiempo donde se 
encuentre el cursor de la línea de tiempo.

 6. Realice una de las siguientes acciones:

 l En la pista de cámara de la vista de línea de tiempo, seleccione el fotograma clave de la 
cámara que desea modificar. 

 l En la vista de escena o de cámara, aleje la vista para ver todos los fotogramas de la cámara. A 
continuación, seleccione el fotograma de la cámara que desea modificar haciendo clic en su 
borde o punto central.

CONSEJO

Incluso si los fotogramas de la cámara se encuentran en la misma posición, puede 
seleccionar uno específico en la vista de escena o de cámara. Justo debajo de la esquina 
inferior izquierda de los fotogramas de la cámara encontrará puntos azules con forma 
cuadrada. Se puede hacer clic en cada uno de estos puntos para seleccionar un 
fotograma de cámara específico. Si dos o más fotogramas clave de la cámara se 
encuentran en la misma posición, el orden de estos puntos representará su posición 
relativa en la línea de tiempo. El punto situado más a la izquierda se puede utilizar para 
seleccionar el primer fotograma clave de la cámara, el segundo punto situado más a la 
izquierda se puede utilizar para seleccionar el segundo fotograma clave de la cámara, 
etc.

60



 7. Utilice uno de los siguientes métodos para modificar el fotograma de la cámara:

 l Mover: Mueva el cursor del ratón sobre el borde o el punto central del fotograma de la cámara 
hasta que el cursor se convierta en  y, a continuación, haga clic y arrastre el fotograma de 
la cámara para moverlo.

 l Aproximar o retirar: Mueva el cursor del ratón sobre el punto situado en la esquina superior 
izquierda del fotograma de la cámara hasta que el cursor se convierta en  y, a continuación, 
haga clic y arrastre esta esquina para contraer o estirar el fotograma de la cámara. Contraer el 
fotograma de la cámara hará que se amplíe, y estirarlo hará que se aleje.

 l Rotar: Mueva el cursor del ratón justo fuera de una de las esquinas del fotograma de la cámara 
hasta que el cursor se convierta en  y, a continuación, haga clic y arrastre la esquina en 
cualquier dirección para rotar el fotograma de la cámara a la derecha o a la izquierda.
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CONSEJO

También puede realizar un desplazamiento pequeño del fotograma de la cámara 
utilizando las teclas de flecha del teclado o introducir sus coordenadas exactas en la vista 
de propiedades de la herramienta.

 8. Repita estos pasos para los demás fotogramas clave de la cámara, si es necesario.

 9. Desplace el cursor de la línea de tiempo al principio de la escena.

 10. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir)  para 
obtener una vista previa del movimiento de la cámara.

Adición de transiciones
Las transiciones son efectos animados que se pueden agregar entre dos escenas para pasar de una escena a la 
siguiente gradualmente, como un fundido o un barrido lineal. Entre otras cosas, la adición de transiciones puede 
ayudar a ajustar el ritmo entre las escenas o a marcar cambios en la configuración de la historia.

Adición de una transición

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione la primera de las dos escenas 
entre las que desee agregar una transición. Por ejemplo, si desea agregar una transición entre las 
escenas 2 y 3, seleccione cualquier panel de la escena 2.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón New Transition (Nueva 
transición) .

 l Seleccione Storyboard > Add Transition (Storyboard > Agregar transición).

 l Haga clic con el botón derecho en las imágenes en miniatura de la escena y seleccione Add 
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Transition (Agregar transición).

 3. Haga clic en la transición para seleccionarla.

 4. Abra la vista de panel Al seleccionar una transición, la vista de panel muestra sus propiedades y 
permite cambiarlas.

 5. En la lista desplegable Type (Tipo), seleccione qué tipo de transición desea utilizar:

 l Dissolve (Fundido): Hace que la primera escena se desvanezca en negro y que la segunda 
aparezca gradualmente en negro.

 l Edge Wipe (Barrido lineal): Elimina la primera escena y la segunda con una línea recta que 
recorre toda la pantalla. El ángulo de la línea se puede personalizar.

 l Clock Wipe (Barrido de reloj): Elimina la primera escena y la segunda con una línea que va del 
centro de la pantalla a su borde y que gira 360 grados para cubrir toda la pantalla. El ángulo y 
la dirección iniciales de la línea se pueden personalizar.

 l Slide (Deslizamiento): Cuando se establece en Slide In (Deslizamiento hacia dentro), la 
segunda escena se desliza desde el borde de la pantalla sobre la primera escena. Cuando se 
establece en Slide Out (Deslizamiento hacia fuera), la primera escena se desliza hacia el borde 
de la pantalla, dejando la segunda escena en la pantalla como si siempre hubiera estado 
detrás de ella. El ángulo al que se desliza la escena hacia dentro o hacia fuera se puede 
personalizar.

 6. Determine la duración de la transición realizando una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic y arrastre el borde derecho de la transición hacia la 
derecha para ampliarlo o hacia la izquierda para reducirlo.

 l En la vista de panel, a la derecha del campo de duración, haga clic en la flecha arriba  para 
ampliar la transición en 1 fotograma, o en la flecha abajo  para reducir la transición en un 
fotograma.

 l En el campo de duración de la vista de panel, escriba la duración de la transición en el formato 
H:MM:SS:FF, donde H significa horas, M significa minutos, S significa segundos y F significa 
fotogramas
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NOTA

Al ampliar una transición, las escenas siguientes se ondulan hacia atrás, y al reducirla, las 
escenas siguientes se ondulan hacia delante. Esto se debe a que las escenas anteriores y 
posteriores de la transición se superponen durante la transición. Esto significa que la 
escena posterior a la transición comienza mientras que la escena anterior a la transición 
aún no ha finalizado, lo que reduce la duración del proyecto.

Adición de sonido

Importación de clips de sonido
Puede importar archivos de sonido en la pista de audio en la línea de tiempo del proyecto. Puede preparar y 
editar clips de sonido para que se sincronicen con la acción en la animática. De manera predeterminada, el 
proyecto tiene una sola pista de audio, pero se pueden agregar más pistas de audio según sea necesario.

Importación de un clip de sonido

 1. En la vista de línea de tiempo, seleccione una pista de audio.

 2. Realice una de las siguientes acciones:

 l Seleccione File > Import Sounds (Archivo > Importar sonidos).

 l Haga clic con el botón derecho en la pista de audio y seleccione Import Sound Clips 
(Importar clips de sonido).

Se abre el cuadro de diálogo Import Sound Clips (Importar clips de sonido).

 3. Haga clic en el botón Browse (Examinar) .
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 4. En el buscador de archivos, localice y seleccione el archivo de sonido que desee agregar a su 
proyecto y haga clic en Open (Abrir).

 5. En el panel Target Sound Track (Pista de sonido de destino), seleccione New Audio Track (Nueva 
pista de audio) si desea crear una nueva pista de audio e importe el archivo de sonido en ella, o 
Current Audio Track (Pista de audio actual) si desea importar el archivo de sonido en la pista de 
audio seleccionada.

 6. En la sección Target Frame (Fotograma de destino), selecciones si desea agregar el clip de sonido al 
First Frame (Primer fotograma) de la pista de sonido o al Current Frame (Fotograma actual), donde 
se encuentra el cursor de la línea de tiempo.

 7. Si ha seleccionado la opción Current Sound Track (Pista de sonido actual), y si hay otros clips de 
sonido en la pista de sonido de destino, especifique qué ocurrirá si el clip de sonido importado es 
demasiado largo y abarca otros clips existentes al seleccionar una opción de Import Rule (Regla de 
importacion):

 l Overwrite Existing Sound Clips (Sobrescribir clips de sonido existentes): Importa el clip de 
sonido y sobrescribe cualquier clip de sonido existente que abarque.

 l Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): Importa el clip de 
sonido y lo corta antes de sobrescribir cualquier clip de sonido existente.

 8. Seleccione la opción Set as default and don’t show dialogue again (Establecer como 
predeterminado y no volver a mostrar el diálogo) si desea utilizar la misma configuración la próxima 
vez que necesite importar un archivo de sonido.

Adición de pistas de audio
Si necesita que se reproduzcan varios clips de sonido al mismo tiempo, debe agregar pistas de audio adicionales 
al proyecto para poder preparar varios clips de sonido en las mismas áreas de la línea de tiempo.

Adición de una pista de audio

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Storyboard > New > New Audio Track (Storyboard > Nuevo 
> Nueva pista de audio).                         

 l En la vista de línea de tiempo, haga clic con el botón derecho en una pista de audio existente 
o en el espacio vacío que se encuentra por debajo de las pistas y seleccione New Audio Track 
(Nueva pista de audio).

 l En la barra de herramientas Clips and Tracks (Clips y pistas), haga clic en el botón New Audio 
Track (Nueva pista de audio) .

Ahora puede importar o mover clips de sonido a la nueva pista de audio.
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Adición de imágenes y vídeos
De forma predeterminada, al crear un proyecto de Storyboard Pro, la única pista que contiene imágenes en la 
animática es la pista del storyboard. Sin embargo, también puede agregar pistas de vídeo al proyecto, que 
puede contener imágenes fijas o archivos de vídeo que se mostrarán por encima o por debajo de la animática. 
Esto puede ser útil si necesita utilizar imágenes o vídeos de referencia, para que elementos como logotipos o 
fondos abarquen varios paneles o escenas, o para insertar vídeos, como secuencias de apertura, secuencias de 
créditos o imágenes de acción en vivo, en la animática.

NOTA

A diferencia de las capas de un panel, los clips de las pistas de vídeo pueden abarcar varios paneles 
y no se ven afectados por los movimientos de la cámara.

Importación de clips de imagen o vídeo
Como el proyecto no incluye de forma predeterminada una pista de vídeo, puede comenzar importando una 
imagen o un vídeo en una nueva pista de vídeo.

Adición de una imagen o vídeo a una pista de vídeo

 1. En el menú superior, seleccione File > Import > Videos/Images as Clip (Archivo> Importar> 
Vídeos/imágenes como clip).

Aparece el cuadro de diálogo Import Videos/Images (Importar vídeos/imágenes).
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 2. Haga clic en el botón Browse (Examinar) .

 3. En el buscador de archivos, localice y seleccione el archivo de imagen o vídeo que desee agregar a su 
proyecto y haga clic en Open (Abrir).

 4. En el panel Destination (Destino), seleccione New Video Track (Nueva pista de vídeo) si el proyecto 
no tiene una pista de vídeo o si desea importar el clip en una nueva pista de vídeo, o Current 
Video Track (Pista de vídeo actual) si desea importarlo en la pista de vídeo actualmente 
seleccionada.

 5. Si ha seleccionado una imagen, establezca la duración deseada de la imagen fija en el campo Clips 
Duration (Duración de los clips). Esto determina la cantidad de fotogramas que abarcará el clip de 
imagen en la línea de tiempo.

 6. Si ha seleccionado la opción Current Video Track (Pista de vídeo actual), y si hay otros clips de vídeo 
en la pista de vídeo de destino, especifique qué ocurrirá si el clip importado es demasiado largo y 
abarca otros clips existentes al seleccionar una opción de Import Rule (Regla de importacion):

 l Overwrite Existing Clips (Sobrescribir clips existentes): importa la imagen o clip de vídeo y 
sobrescribe cualquier clip existente que abarque.

 l Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): importa la imagen o 
clip de vídeo y la corta antes de sobrescribir cualquier clip existente.

 7. Haga clic en OK (Aceptar).

Se crea una pista de vídeo encima de la pista del storyboard, y se agrega la imagen o vídeo como un 
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clip de vídeo.

 8. Si desea que la pista de vídeo se muestre detrás de la animática, haga clic con el botón derecho en la 
pista de vídeo y seleccione Move Track Down (Desplazar pista hacia abajo).

Adición de pistas de vídeo
Al igual que las pistas de audio, puede agregar varias pistas de vídeo al proyecto y hacer que los clips se 
superpongan entre sí.

Adición de una pista de vídeo

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Storyboard > New > New Video Track (Storyboard > Nuevo 
> Nueva pista de vídeo).                         

 l En la vista de línea de tiempo, haga clic con el botón derecho en una pista de vídeo existente 
o en el espacio vacío que se encuentra por debajo de las pistas y seleccione New Video Track 
(Nueva pista de vídeo).

 l En la barra de herramientas Clips and Tracks (Clips y pistas), haga clic en el botón New Video 
Track (Nueva pista de vídeo) .                         

Ahora puede importar o mover clips de vídeo a la nueva pista de vídeo.
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Capítulo 9: Trabajo en 3D
Storyboard Pro permite manipular capas de dibujo en el espacio 3D e integrar modelos 3D en el storyboard. Si 
el proyecto utiliza modelos 3D, puede importarlos en el proyecto y, a continuación, insertarlos en los paneles en 
lugar de tener que dibujarlos.

Conversión de una escena en 3D
Al crear una escena, se crea en modo 2D de forma predeterminada. Esto significa que las capas están 
bloqueadas en la misma posición en el eje z y solo se pueden rotar sobre el eje z. Esto es para evitar dificultar el 
flujo de trabajo con funciones 3D que no son necesarias.

Puede convertir fácilmente una escena 2D a 3D, y viceversa. En una escena 3D, puede mover capas en el eje z y 
rotarlas en cualquier dirección. También puede rotar la cámara en cualquier dirección y hacer que se mueva a 
través de la profundidad de la escena. Del mismo modo, puede rotar la vista de escena en cualquier ángulo y 
navegar por la escena detenidamente, lo que le permite verla desde varios puntos de vista.

NOTA

Puede convertir una escena en 3D, pero no un solo panel. Al cambiar al modo 3D, este solo se aplica 
a la escena actual, no a todo el proyecto.

Activación de la opción 3D

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione la escena que desea convertir 
en 3D.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón Enable 3D (Activar 3D) .

 l Seleccione Storyboard > Enable 3D for Current Scene (Storyboard > Activar 3D para la 
escena actual).

Restablecimiento de una escena a 2D
Puede restablecer una escena 3D a 2D. Al hacer esto, se realizan los siguientes cambios en la escena:

 l Se eliminan los modelos 3D importados.

 l Los movimientos de cámara 3D se convierten en movimientos de cámara 2D. Los movimientos de la 
cámara en el eje z se convertirán en acercamientos y alejamientos de la cámara 2D, pero se ignorarán las 
rotaciones 3D.
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 l Las transformaciones 3D en capas se convierten en transformaciones 2D. Las capas que se han movido 
en el eje z se ampliarán o reducirán para conservar sus proporciones aparentes, pero se ignorarán las 
rotaciones 3D.

Restablecimiento de una escena a 2D

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas Storyboard, haga clic en el botón Reset Scene to 2D 
(Restablecer escena a 2D) .

 l Seleccione Storyboard > Reset Scene to 2D (Storyboard > Restablecer escena a 2D).

Visualización de objetos desde la parte superior y lateral
Al trabajar en 3D, se puede utilizar la vista de escena para mirar la escena desde cualquier punto de vista y 
desde cualquier ángulo. Esto permite ver cómo se colocan los objetos en el espacio, y puede utilizar la vista de 
cámara para ver la escena desde el punto de vista de la cámara. Sin embargo, es probable que a menudo 
necesite tener un control preciso sobre cómo se colocan los objetos y las capas en el eje z.

Las vistas superior y lateral permiten ver la escena desde su parte superior y lateral, respectivamente. Dado que 
estas vistas no aplican perspectiva a la escena, se pueden utilizar para colocar elementos con más precisión. 
Con la vista lateral, puede ver y colocar capas y objetos en el eje delantero-trasero (z), así como en el eje norte-
sur (y). Con la vista superior, puede ver y colocar capas y objetos en el eje delantero-trasero (z), así como en el 
eje este-oeste (x). Por lo tanto, ambas vistas combinadas pueden ayudar a colocar objetos en el eje z sin perder 
de vista su posición en los otros ejes.

Las vistas superior y lateral muestran capas 2D como segmentos finos, como si estuviera mirando las hojas de 
papel desde un lateral. Puede seleccionar y manipular capas 2D de forma manual directamente desde estas 
vistas.
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Visualización de las vistas superior o lateral

 l En la esquina superior derecha de cualquier vista, haga clic en el botón Add View (Agregar vista)  
y seleccione Side View (Vista lateral) o Top View (Vista superior).

 l En el menú superior, seleccione Windows > Side View o Top View (Ventanas > Vista superior o 
Vista lateral).

Colocación de elementos 2D en el espacio 3D
En una escena 3D, las capas de dibujo se pueden manipular como objetos 3D. Puede colocarlas más cerca o más 
lejos de la cámara, lo que permite crear un efecto de multiplano. También puede rotarlas en cualquier dirección, 
lo que permite realizar falsas construcciones 3D, como espacios abiertos.

Colocación de un elemento 2D en el espacio 3D

 1. En la barra de herramientas Tools (Herramientas), seleccione el botón Layer Transform 
(Transformación de capas) .

 2. En la vista de escena, seleccione el elemento que desea .cambiar de lugar

Aparece un manipulador de transformación 3D sobre la capa en las vistas de escena, de cámara, 
superior y lateral.

 3. Este manipulador 3D tiene una flecha azul en la que puede hacer clic y arrastrarla para mover la 
capa en el eje z. Sin embargo, dado que esta flecha azul se encuentra directamente frente a la vista 
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de escena, no puede hacer clic y arrastrarla. En su lugar, debe seguir uno de los siguientes enfoques:

 l Haga clic y arrastre la flecha azul en la vista superior o en la vista lateral. Si arrastra la capa 
más cerca de la punta del cono de la cámara, se acercará a la cámara y se mostrará más 
grande. Si la arrastra desde la punta del cono de la cámara, se encontrará más atrás y se 
mostrará más pequeña.

 l Rote el punto de vista de la vista de escena manteniendo pulsado Ctrl + Mayús (Windows) o 
mayúsculas + ⌘  (macOS) y, a continuación, haciendo clic y arrastrando la vista. Cuando la 
vista de escena se encuentra en cualquier ángulo, excepto en el predeterminado, podrá hacer 
clic y arrastrar la flecha azul y mover la capa a través del eje z.

Al arrastrar el elemento por el espacio 3D, la posición del elemento también se actualizará en las 
otras vistas.
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Importación de modelos 3D
Puede integrar modelos 3D en el proyecto importándolos en la librería y, a continuación, arrastrándolos y 
colocándolos en los paneles donde sean necesarios. Cada proyecto de Storyboard Pro tiene su propia librería de 
modelos 3D. Como cada instancia del modelo proviene de la librería del proyecto, Storyboard Pro no tiene que 
almacenar una copia del modelo para cada panel que la utilice.

Storyboard Pro admite los siguientes tipos de modelos 3D:

 l Filmbox (.fbx)

 l 3DS Max (.3ds)

 l Wavefront OBJ (.obj)

 l Allembic (.abc)

 l Collada (.dae)

Se recomienda utilizar el formato Filmbox (.fbx), ya que se puede empaquetar con texturas integradas en el 
modelo.

Importación de un objeto 3D en la librería

 1. En la vista de librería, haga clic con el botón derecho en la carpeta de la librería de modelos 3D y 
seleccione Import Files (Importar archivos).

 2. En el buscador de archivos, localice y seleccione el modelo 3D.

El modelo seleccionado aparece en la carpeta de modelos 3D de la vista de librería.

 3. Arrastre y coloque el modelo 3D de la vista de librería a la vista de escena o de cámara:

 l Para insertarlo entre dos capas específicas, colóquelo entre esas capas en el panel Layer 
(Capa) de la vista de escena o de cámara. 

 l Si desea insertarlo sobre las demás capas, puede colocarlo directamente en la vista de escena 
o de cámara. 

El modelo 3D se inserta en el panel con su tamaño original y en el centro de la escena.

NOTA

Si elimina un modelo 3D de la biblioteca, se eliminarán del proyecto todas las instancias de ese 
modelo.
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Manipulación de objetos 3D
Si selecciona un modelo 3D con la herramienta Layer Transform  (Transformación de capas), aparecerá un 
manipulador de transformación 3D sobre él en las vistas de escena, cámara, superior y lateral. El manipulador 
de transformación para modelos 3D es un cubo con controles dentro para desplazarse, rotar y escalar el modelo 
sobre cualquiera de los tres ejes.

Un modelo 3D que se acaba importar en un panel se encontrará frente a la cámara. En consecuencia, el cubo de 
su manipulador 3D también se encontrará frente a la cámara, proporcionándole un aspecto de cuadrado. En 
este ángulo, no podrá desplazarse o escalar el modelo sobre el eje z. Para evitarlo, debe rotar la vista de escena, 
utilizar las vistas superior o lateral, o rotar el modelo en sí.

Rotación de la vista de escena en 3D

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), haga doble clic en la herramienta Hand 
(Mano)  y seleccione la herramienta 3D Navigation (Navegación 3D) .

 l Mantenga pulsado Ctrl + Mayús (Windows) o mayúsculas + ⌘  (macOS).

 2. Haga clic y arrastre el interior de la vista de escena para rotarlo en todas las direcciones.

Manipulación de un objeto 3D

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Layer Transform 
(Transformación de capas) .

 2. Seleccione el modelo 3D que desea manipular.
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 3. En la vista de escena, cámara, superior o lateral, realice una de las siguientes acciones:

 l Para trasladar el modelo sobre el eje x, haga clic y arrastre la flecha roja.

 l Para trasladar el modelo sobre el eje y, haga clic y arrastre la flecha verde.

 l Para trasladar el modelo sobre el eje z, haga clic y arrastre la flecha azul.

 l Para trasladar el modelo lateralmente en relación con su punto de vista, haga clic y arrastre 
su geometría.

 l Para rotar el modelo sobre el eje x, haga clic y arrastre el círculo rojo.

 l Para rotar el modelo sobre el eje y, haga clic y arrastre el círculo verde.

 l Para rotar el modelo sobre el eje z, haga clic y arrastre el círculo azul.
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 l Para rotar el modelo en cualquier dirección, haga clic y arrastre sobre su círculo externo.

 l Para escalar el modelo sobre el eje x, haga clic y arrastre sobre el punto cuadrado rojo.

 l Para escalar el modelo sobre el eje y, haga clic y arrastre sobre el punto cuadrado verde.

 l Para escalar el modelo sobre el eje z, haga clic y arrastre sobre el punto cuadrado azul.

 l Para escalar el modelo sobre todos los ejes, haga clic y arrastre cualquier vértice del cubo.

CONSEJO

Si necesita rotar o escalar el modelo 3D desde un punto pivote específico, puede mover 
el punto pivote del modelo 3D haciendo clic y arrastrando el pivote del centro del 
manipulador. El manipulador y su pivote se moverán, pero no el modelo.

Vista previa de escenas 3D
En Storyboard Pro, la vista de escena es la vista predeterminada para dibujar y manipular objetos. Sin embargo, 
cuando se trabaja en 3D se presenta una dificultad: al panear, rotar, acercar o alejar la vista de escena, cambiará 
el punto de vista desde el que mira la escena. Esto significa que es posible que la posición aparente y el tamaño 
de los elementos no sean representativos de lo que aparecerá en el storyboard o la animática.

Si desea ver una escena 3D exactamente tal y como se verá en el storyboard, debe utilizar la vista de cámara. La 
vista de cámara siempre muestra la escena desde el punto de vista de la cámara, incluso si la panea, la rota o la 
acerca o aleja. Por lo tanto, siempre se debe obtener una vista previa de la escena desde la vista de cámara si se 
realizan cambios en la posición de la cámara o de los objetos 3D para asegurarse de que la composición de la 
escena sea la esperada.
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Adición de la vista de cámara al espacio de trabajo

 1. Realice una de las siguientes acciones:

 l En la esquina superior derecha de la vista de escena, haga clic en el botón Add View 
(Agregar vista)  y, a continuación, seleccione Camera View (Vista de cámara).

 l En el menú superior, seleccione Windows > Camera View (Ventanas > Vista de cámara).
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Capítulo 10: Creación e importación de plantillas
Una plantilla es una copia que hace de una o varias capas, o de uno o varios paneles, en una librería. Una vez 
que haya creado una plantilla, puede volver a importarla tantas veces como necesite, ya sea en el mismo 
proyecto o en un proyecto diferente.

NOTA

Al crear una plantilla, no está vinculada al proyecto original. Se crea una copia de los recursos para la 
plantilla, y puede modificar el proyecto original sin que afecte a su plantilla. Del mismo modo, al 
importar una plantilla en el proyecto, se copia en el mismo. La realización de cambios en la plantilla 
no afectará a sus copias importadas, y puede realizar cambios en los recursos importados sin que 
afecten a la plantilla.

Creación de plantillas de capas
Puede crear una plantilla de una o varias capas desde el panel Layer (Capa) en la vista de escena o de cámara.

Creación de una plantilla de una o varias capas utilizando la vista de escena o de 
cámara

 1. En la vista de librería, seleccione una carpeta para almacenar la plantilla.

 2. En el panel Layer (Capa) de la vista de escena o de cámara, seleccione una o varias capas. Para 
seleccionar varias capas, realice una de las siguientes acciones:

 l Mientras mantiene pulsado Mayús, haga clic en la primera capa que desee agregar a la 
selección y, a continuación, en la última capa que desee agregar a la selección. Todas las capas 
intercaladas formarán parte de la selección.

 l Mientras mantiene pulsado Ctrl (Windows) o ⌘  (macOS), haga clic en cada capa que desee 
agregar a la selección. 

 3. Arrastre y coloque la selección en la vista de librería.

 4. En el cuadro de diálogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantilla.
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NOTA

También puede cambiar el nombre de una plantilla después de crearla haciendo clic con el 
botón derecho sobre ella y seleccionando Rename (Cambiar nombre).

Importación de plantillas de capas
Puede importar una plantilla de capas en un panel utilizando la vista de escena o de cámara.

Importación de una plantilla de capa en la vista de escena o de cámara

 1. En la vista de imágenes en miniatura o de línea de tiempo, seleccione el panel en el que desea 
insertar la plantilla.

 2. En la vista de librería, seleccione la plantilla que desea importar.

 3. Arrastre y coloque la plantilla en la vista de escena o de cámara:

 l Para insertarlo entre dos capas específicas, colóquelo entre esas capas en el panel Layer 
(Capa) de la vista de escena o de cámara. 

 l Si desea insertarlo sobre las demás capas, puede colocarlo directamente en la vista de escena 
o de cámara. 

Creación de plantillas de paneles
Puede crear una plantilla de uno o varios paneles utilizando la vista de imágenes en miniatura o de línea de 
tiempo.

Creación de una plantilla de paneles utilizando la vista de imágenes en miniatura

 1. En la vista de librería, seleccione una carpeta para almacenar la plantilla.
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 2. En la vista de imágenes en miniatura, seleccione uno o varios paneles. Para seleccionar varios 
paneles, realice una de las siguientes acciones:

 l Mientras mantiene pulsado Mayús, haga clic en el primer panel que desee agregar a la 
selección y, a continuación, en el último panel que desee agregar a la selección. Todos los 
paneles intercalados formarán parte de la selección.

 l Mientras mantiene pulsado Ctrl (Windows) o ⌘  (macOS), haga clic en cada panel que desee 
agregar a la selección.

 3. Haga clic y arrastre el controlador de arrastrar y colocar  de uno de los paneles seleccionados y, a 
continuación, coloque la selección en la vista de librería.

 4. En el cuadro de diálogo Rename (Cambiar nombre), cambie el nombre de la nueva plantilla.

Creación de una plantilla de paneles utilizando la vista de línea de tiempo

 1. En la vista de librería, seleccione una carpeta para almacenar la plantilla.

 2. En la vista de línea de tiempo, seleccione uno o varios paneles. Para seleccionar varios paneles, 
realice una de las siguientes acciones:

 l Mientras mantiene pulsado Mayús, haga clic en el primer panel que desee agregar a la 
selección y, a continuación, en el último panel que desee agregar a la selección. Todos los 
paneles intercalados formarán parte de la selección.

 l Mientras mantiene pulsado Ctrl (Windows) o ⌘  (macOS), haga clic en cada panel que desee 
agregar a la selección.

 3. Arrastre y coloque los paneles seleccionados en la vista de librería.
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 4. En el cuadro de diálogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantilla.

Importación de plantillas de paneles
Puede importar una plantilla de panel en la vista de imágenes en miniatura o de línea de tiempo.

Importación de una plantilla de paneles en la vista de imágenes en miniatura

 1. En la vista de librería, seleccione la plantilla que desea importar.

 2. Arrastre y coloque la plantilla seleccionada en la vista de imágenes en miniatura, entre los dos 
paneles en los que desee que se inserte.
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Importación de una plantilla en la vista de línea de tiempo

 1. En la vista de librería, seleccione una plantilla para importarla.

 2. Arrastre la plantilla seleccionada en la vista de línea de tiempo, entre los dos paneles en los que 
desee que se inserte.
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Capítulo 11: Exportación del proyecto
Una vez que haya terminado el storyboard o la animática, puede exportarlos para llevarlos a la siguiente fase de 
la producción.

Si se fija en el menú superior File > Export (Archivo > Exportar), verá que existen varias maneras de exportar el 
proyecto En este capítulo se presentarán los tres tipos de exportación que más se utilizan:

 l PDF: al exportar e storyboard como un formato de documento portátil (.pdf), se crea un documento que 
contiene un storyboard de animación de estilo tradicional que presenta cada panel en su orden 
cronológico, con sus números de escena y panel, así como sus leyendas. En este formato, puede 
imprimirlo o compartirlo digitalmente, y puede usarse como referencia o como material de presentación.

 l Película: al exportar la animática como película, puede compartirla con los colaboradores del proyecto e 
importarla en un software de terceros.

 l Harmony: puede exportar cada escena en la animática en escenas independientes de Toon Boom 
Harmony, con los paneles insertados en las escenas para que puedan usarse como referencia para crear 
la animación. Si tiene la intención de crear la animación en Storyboard Pro, esta acción permite pasar 
rápidamente la producción de la fase de creación de storyboard a la animación.

Exportación de un PDF
La exportación de un PDF creará un storyboard de animación tradicional que muestra los paneles junto con su 
número de escena y panel y sus leyendas.

NOTA

La visualización de un archivo PDF requiere un lector de PDF, como Adobe Reader, que puede 
descargar de la siguiente página: https://get.adobe.com/reader/

Exportación de un PDF

 1. En el menú superior, seleccione File > Export > PDF (Archivo > Exportar > PDF).

Se abre el cuadro de diálogo Export to PDF (Exportar a PDF).
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 2. En el campo Destination Path (Ruta de destino), especifique la ubicación y el nombre del archivo.

 3. En la sección PDF Export Parameters (Parámetros de exportación de PDF), seleccione un layout 
para el archivo PDF. En una animación occidental, el formato más fácil para los storyboards es 3 
Panels Horizontal (3 paneles horizontales).

 4. En la sección Export Range (Rango de exportación), seleccione si desea generar un archivo que 
incluya el storyboard completo, planos específicos o los paneles seleccionados actualmente. 

 5. Si desea ver el storyboard después de haberlo exportado, marque la casilla de verificación Open 
document after export (Abrir documento tras exportación).

 6. Haga clic en  Export (Exportar).

Exportación de una película
Una vez que haya creado el storyboard y la animática, puede exportarlos como un archivo de película para 
compartirlos con los colaboradores del proyecto o importarlos en un software de terceros. Puede exportar la 
animática como un archivo de vídeo con audio, o como una secuencia de archivos de imagen. Esta última se 
puede agrupar en Harmony o en un software de terceros.

Exportación de una película

 1. En el menú superior, seleccione File > Export > Movie (Archivo > Exportar > Película).

Se abre el cuadro de diálogo Export to Movie (Exportar a película).
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 2. En Destination Path (Ruta de destino), seleccione una carpeta en la que desee guardar la película. 
Puede escribir la ruta exacta o usar el botón Browse (Examinar)  para buscar una carpeta 
específica en el sistema.

CONSEJO

Si tiene la intención de exportar secuencias de imágenes o varios archivos de películas, 
se recomienda crear una carpeta específica para exportar los archivos.

 3. En el panel Export Movie Format (Exportar formato de película), configure las siguientes opciones:

 l En la lista desplegable Movie Format (Formato de película), seleccione un formato de 
exportación:

 l QuickTime Movie (*.mov) para exportar un vídeo en formato Apple QuickTime.

 l Windows Media Video (*.wmv) para exportar un vídeo en formato Windows 
Media Video.

 l Flash (*.swf) para exportar archivos Flash.

 l Jpeg (*.jpg), Targa (*.tga) o Portable Network Graphics (*.png) para exportar 
una secuencia de imágenes.
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NOTA

El formato Windows Media Video (.wmv) solo se encuentra disponible en  
Windows. El formato QuickTime Movie (.mov) requiere que se instale 
Apple QuickTime. 

 l En la lista desplegable Resolution (Resolución), seleccione si desea que la película 
exportada tenga el tamaño Full Size (Tamaño completo), Half Size (Tamaño medio) o 
Quarter Size (Un cuarto), en relación con la resolución del proyecto. Se recomienda 
exportar la animática en tamaño completo, a menos que desee exportar rápidamente 
un vídeo de prueba.

 l En la lista desplegable One Clip (Un clip), seleccione cómo desea que se separen los 
clips de vídeo:

 l Per Scene (Por escena): Crea un archivo de película para cada escena del 
proyecto.

 l Per Sequence (Por secuencia): Crea un archivo de película para cada secuencia 
del proyecto, si la hubiera.

 l Per Project (Por proyecto): Exporta toda la animática en un solo archivo de 
vídeo.

 4. En la pestaña Export Range (Rango de exportación), decida si desea exportar todo el proyecto (All), 
las escenas seleccionadas (Selected Scenes), la escena actual (Current Scene), el panel actual 
(Current Panel) o los paneles de seguimiento (Tracked Panels). Al exportar las escenas 
seleccionadas, puede seleccionar qué escenas (o secuencias, si el proyecto contiene secuencias) 
desea exportar haciendo clic en Select (Seleccionar) para abrir el cuadro de diálogo Scene Picker 
(Selector de escena).
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NOTA

Para obtener más información sobre Tracked Panels (Paneles de seguimiento), consulte 
la Storyboard ProGuía del usuario de .

 5. Si desea reproducir automáticamente el vídeo o ver los archivos exportados una vez realizada la 
exportación, marque la opción Open document/folder after export (Abrir documento/carpeta tras 
exportación).

 6. Haga clic en  Export (Exportar).

Exportación a Harmony
Storyboard Pro puede exportar automáticamente cada escena del proyecto en una escena que se puede abrir 
en Harmony, donde puede utilizar la animática para crear y programar la animación. Las escenas de Harmony 
resultantes tendrán la misma longitud que las escenas del proyecto de Storyboard Pro. Contendrán cada uno 
de sus paneles para que pueda animar sobre ellos, y contendrán su parte correspondiente de la pista de sonido 
de la animática.

Exportación a Harmony

 1. En el menú superior, seleccione File > Export > Export to Harmony (Archivo > Exportar > Exportar a 
Harmony).
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Se abre el cuadro de diálogo Export to Harmony (Exportar a Harmony).

 2. En Destination Path (Ruta de destino), seleccione una carpeta en la que desee exportar las escenas 
de Harmony. Puede escribir la ruta exacta o usar el botón Browse (Examinar)  para buscar una 
carpeta específica en el sistema.

CONSEJO

Se recomienda crear una carpeta específica para exportar las escenas, ya que 
Storyboard Pro generará varios archivos y carpetas para la exportación.

 3. En la lista desplegable Format (Formato), seleccione una de las siguientes opciones:

 l Harmony Offline (Harmony desconectado): Creará escenas que se pueden abrir en  Harmony 
Stand Alone.

 l Harmony Database (Base de datos de Harmony): Creará un paquete de escenas que se 
pueden importar en una base de datos de Harmony Server.

 4. Seleccione uno de los siguientes tipos de exportación, dependiendo de la herramienta con la que 
prefiera trabajar y.
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 l Animática renderizada: Renderiza la animática en una secuencia de imágenes de mapa de 
bits agrupadas en escenas de Harmony. Esto garantiza que el contenido de la animática se 
renderice con precisión en Harmony, especialmente si tiene la intención de utilizar una 
versión anterior.

 l Escena original: Exporta la animática directamente en escenas de Harmony sin renderizarla. 
Esto conserva las capas, dibujos y movimientos de la cámara para que puedan utilizarse en 
Harmony. 

 5. Si desea ver los archivos exportados una vez realizada la exportación, marque la casilla de 
verificación Open document/folder after export (Abrir documento/carpeta tras exportación).
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